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1. PLANTEAMIENTO DEL PROBLEMA 
 
La cordillera occidental plantea un desafío por su topografía de alta pendiente, se 
muestra como un obstáculo al momento de buscar una posible salida desde la 
cabecera municipal de Peque hacia la capital del departamento de Antioquia. 
 
La única vía que da salida hacía Medellín y el Urabá antioqueño es por el 
municipio de Uramita, con una longitud de 63 kilómetros, vía que históricamente 
se ha mantenido en mal estado, en parte por fallas geológicas.  
 
El tiempo que tarda en llegar a el municipio de Uramita es de 7 a 8 horas cuando 
no hay derrumbes. Adicional a esto, se tiene la pérdida de banca en varios puntos 
del trayecto, situación que empeora en época de invierno, dejando incomunicada a 
una comunidad de más de 10.000 personas 
 
De los 63 kilómetros que hay entre estos dos municipios, solo 1.3 están 
pavimentados, situación que hacen de Peque uno de los 23 municipios de 
Antioquia que aún no cuentan con un acceso pavimentado. 
 
A pesar de las dificultades, se plantea una posible salida que conecte a dicho 
municipio con el corregimiento Tabacal del municipio de Buriticá, aprovechando 
ciertos carreteables existentes, con un trazado que cumple con normas de diseño. 
 
En la actualidad se está construyendo un tramo de vía desde el sector de El 
Siento hasta la vereda La Cordillera, pensando en darle continuidad en un futuro 
con el Corregimiento de Llanos de Urarco, el más lejano del municipio de Buriticá.  
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2. JUSTIFICACIÓN 

 

Es innegable la necesidad que tienen las comunidades de interconectarse por 
cualquier medio de comunicación, más aún cuando son comunidades muy 
alejadas de los centros de actividad económica. Las vías son una urgencia 
manifiesta, en zonas del territorio nacional que han sido muy afectadas por 
fenómenos naturales, de violencia sistemática a través de los tiempos, falta de 
educación de calidad, aún en muchas zonas no disponen de servicio de energía, 
de agua potable entre otros. 
 
El objetivo de este trabajo de grado es presentar una alternativa de comunicación 
entre dos municipios del departamento de Antioquia haciendo uso principalmente 
del programa ArcGIS, aplicado al diseño de vías, al menos en etapa de 
factibilidad.  
 
El programa Arc GIS nos permite plantear una o varias alternativas de solución al 
problema de comunicación que presenta el municipio de Peque, diferente a la 
única vía de comunicación con que cuenta dicho municipio. Además del programa, 
también se dispone de imágenes satelitales que se adquieren de forma gratuita en 
la red, y con un grado de precisión aceptable.  
 
El resultado que se espera es tener finalmente un proyecto que cumpla normas de 
diseño, una mínima afectación al medio ambiente, brindar otra vía de acceso a la 
zona, una mejor calidad de vida de los pobladores. 
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3. OBJETIVO GENERAL 
 
Implementar un Sistema de Información Geográfica en la planeación y control del 
diseño y trazado de la vía La Cordillera y el corregimiento de Llanos de 
Urarco, municipio de Buriticá-Antioquia.  
 
3.1 Objetivo específico 
 
Obtener imágenes de sensores remotos activos (radar Alos Palsar) y pasivos 
(Landsat8). 
 
Obtener información secundaria base de suelos y de cobertura vegetal para 
posterior análisis. 
 
Generar un modelo de elevación digital para obtener la topografía y diseñar el 
trazado y el perfil. 
 
Analizar la información obtenida para identificar riesgos, manejo de cobertura y 
obras para protección de cauces. 
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4. MARCO REFERENCIAL 
 
Tema: Trazado de una vía alterna que comunique al municipio de Peque, pasando 
por el corregimiento de Llanos de Urarco del municipio de Buriticá, hasta Medellín. 
 
Antecedentes: Solo se hace reseña de la vía que se construye actualmente entre 
el corregimiento de Tabacal y la vereda La Cordillera, tiene una longitud de 4 
kilómetros y unirá el 50% de la población rural con su cabecera municipal. No hay 
investigaciones al respecto, ni estudios previos; para ir al corregimiento de Llanos 
de Urarco se hace por un tramo de moto ruta, el resto por camino de herradura 
 
Bases teóricas: A causa de la difícil topografía en todo el municipio, la 
comunicación rural se hace en su mayoría por caminos veredales y senderos 
ecológicos.   
 

• ¿Cuál es el contexto social y político sobre el cual se han llevado a cabo las 
políticas públicas para llevar el desarrollo a las zonas más apartadas del 
municipio y que no cuentan con vías de acceso eficientes y seguras, que 
garanticen el acceso a los mercados tanto internos como externos? 

 

• ¿Cuál es la posición de los gremios económicos y políticos para impulsar 
obras de gran calado en el medio rural que jalonen el desarrollo sostenido 
de la zona impactada con una obra como esta? 
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5. DISEÑO METODOLÓGICO 

 

5.1 Elaboración del mapa con ArcGIS 
 
Los Sistema de Información Geográfica (SIG) son programas que permiten 
la integración de la información geográfica de una zona de referencia. Son 
herramientas que permite analizar los resultados producto del uso de 
información espacial como mapas. 
 
Los SIG ofrecen la posibilidad de separar en capas temáticas, toda la 
información almacenándola de forma independiente, permite relacionar la 
información con el fin de generar otra capa con otras características y con 
otro fin. 
 

 
Figura 1. Ejemplo de capas temáticas en SIG. (Fuente: UNSW Escuela de 

Topografía y Geoespacial Ingeniería (SAGE)) 

https://en.wikipedia.org/wiki/UNSW
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Los sistemas de información geográfica se almacenan de dos formas: 
Ráster y Vectorial. Con el sistema vectorial se tiene la ventaja de poder 
integrar la información con el sistema CAD fácilmente, además de 
proporcionar una elevada precisión con mejor calidad de imagen y crear 
ficheros de poco tamaño. 

 
5.2 Herramientas de ArcGIS 
 

El programa ArcGIS es un producto de la empresa ESRI, el cual tiene 
varias aplicaciones para la captura, edición, análisis, tratamiento, diseño, 
publicación e impresión de la información geográfica. A continuación, 
algunas de ellas: 

• ArcMap: Es aplicación central para la visualización y manipulación 
de datos geográficos. 

• ArcCatalog: Es la aplicación que se utiliza para gestionar los 
archivos que se van a utilizar: mapas, bases de datos, etc. Ayuda a 
organizar la información geográfica y es imprescindible para 
mantener un orden. 

• ArcToolBox: Sirve para realizar operaciones de procesamiento de la 
información geográfica: análisis de datos espaciales, conversión de 
formatos, gestión de datos y muchas operaciones más. 

• ArcScene: Permite visualizar los datos en tercera dimensión (3D). 
 

 
5.3 Búsqueda de información geográfica. 
 

Se lleva a cabo con programas satelitales, con la localización de satélites 
que se encuentran en el espacio actualmente y descargando una imagen 
gratuita desde la página del Earth Explorer del USGS ((United State 
Geological Survey) para elaborar el presente trabajo. Se entra a la página 
de Earth Explorer y se registra en: https://earthexplorer.usgs.gov/. 
 
Luego se procede a registrarse en la página para poder tener acceso a los 
mapas e imágenes. Una vez dentro de la página citada, (Fig. 2), dirigirse al 
enlace de registro, dar clic en Login y luego en Create New Account, y se 
desplegará el formulario de registro. 

 
Luego se diligencia los campos para crear un nuevo usuario, crear la 
respectiva contraseña, diligenciar la pregunta de seguridad (Fig. 3); Dar clic 
en continuar y terminar de diligenciar la información solicitada en los 
espacios dispuestos para ello. 

https://earthexplorer.usgs.gov/
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Figura 2. Página del Earth Explorer del USGS 
 

 

 
Figura 3. Diligenciamiento de los campos para crear un nuevo usuario. 

 
Una vez registrado, se puede consultar y descargar imágenes, recordar que 
si no se está registrado se puede consultar mas no se puede descargar 
información. 
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Una vez registrado, volver a “home” del sitio web haciendo clic en el 
enlace del lado derecho, luego en el visor, navegar con la herramienta 
interactiva de paneo hasta el sitio donde se desarrollará el proyecto, en este 
caso busco la zona entre los corregimientos Tabacal y Llanos de Urarco del 
municipio de Buriticá, departamento de Antioquia. (Fig. 4).  
 

 
 

Figura 4. Ubicación de la zona de desarrollo del proyecto. 
 

Con el mouse se da clic izquierdo en el punto de interés como se observa 
en la figura anterior y se verifica que las coordenadas sí correspondan al 
sitio de interés. 
 

 
 

Figura 5. Coordenadas de la zona de desarrollo del proyecto. 
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5.4 Determinar el tipo de imagen de interés. 
 

Continuando con el proceso, se procede a dar clic donde dice “data sets” y 
ver como se despliega una ventana con la información que se necesita, 
Figuras 6 y 7.  
 

 
 

Figura 6. Botón “Data Sets” para el despliegue del tipo de datos. 
 

 

 
 

Figura 7. Árbol desplegado de tipos de datos que se pueden consultar. 
 

Al desplegarse una ventana, se abre el vínculo “Landsat” y allí 
nuevamente en “Landsat Collection 2 Level-1”, selecciona los elementos, 
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allí nuevamente en “Landsat Collection 2 Level-1” selecciones los 
elementos como se observa en la siguiente imagen.  
 

 
 

Figura 8. Selección de archivos de Landsat. 
  

Una vez llevado a cabo, se procede a ir al menú de la parte derecha que 
dice “Results” resultados (Fig. 9) y el programa inicia la búsqueda de la 
imagen.  
 

 
 

Figura 9. Link de resultados. 
 

5.5 Realizar la búsqueda. 
 

Al dar clic en “Results” resultados, aparece una nueva ventana que 
muestra las diferentes imágenes de satélite disponibles para ser evaluadas 
y seleccionar la que cumpla con las características deseadas. 
 

Luego se da clic sobre cada pequeña imagen de la parte izquierda para ver 
si cumple con lo que se busca. Lo principal es que tenga poca o ninguna 
cobertura de nubes. Fig. 11. 
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Figura 10. Listado de imágenes disponibles. 
 

 
 

Figura 11. Ventana de previsualización de una imagen seleccionada. 
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5.6 Selección y descarga de la imagen. 
 

Una vez tenga seleccionada la imagen, en las opciones de visualización de 
la escena, en el visor geográfico se da clic al segundo ícono. Éste permite 
visualizar la zona que cubre dicha imagen en la superficie terrestre en forma 
de cuadrado. 
 

 
 

Figura 12. Previsualización de una imagen seleccionada. 
 

Una vez seleccionada la imagen se procede a la descarga dando clic en el 
quinto ícono de izquierda a derecha del menú mostrado en el Data Set: 

, “Download Options” 
 

A continuación, saldrá un cuadro de diálogo con las diferentes opciones de 
descarga, que van desde el conjunto de todas las bandas que componen la 
imagen hasta la composición en color de ésta (Figura 13). Está también el 
tamaño del archivo en megabytes, el cual descarga comprimido, lo que 
obliga a contar con un programa para descomprimirlo. 

 
Vale la pena recordar que para descargar la información se debe contar con 
un registro previo en la plataforma. 
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Los programas para descomprimir pueden ser WinRAR o Winzip. 
 
 

 
 

Figura 13. Cuadro de diálogo para descarga de la información. 
 

En la imagen 14 se puede apreciar con que tipo de información cuenta, es 
importante tener en cuenta el tipo de formato de las bandas (.tif) y los 
metadatos que son los archivos de apoyo. 
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Figura 14. Archivos descargados descomprimidos utilizados. 
 

Con esto concluye el trabajo de descarga de la imagen de Satélite Landsat 
de la página Earth Explorer del USGS de los Estados Unidos. 

 

5.7 Análisis espectral 
 

Con la imagen Lansat descargada se realiza un proceso preliminar, el cual 
permite hacer un análisis visual por medio de varias composiciones de 
color; para ello se hace lo siguiente: 
 

• Se descomprimen las bandas que componen la imagen mediante 
WinRAR y se guardan en una carpeta. 

• Se abre el programa ArcGIS en blanco y se cargan las bandas 

haciendo clic en el ícono “añadir datos” (Add Dat) , ver figura 
15. 

 
Aparecen las imágenes en la tabla de contenidos de ArcGIS, luego se 
realiza el empaquetado de la imagen con la herramienta “Composite 

Band” ubicada en ArcToolBox . 
 

Se abre ArcToolBox y se despliega una caja de herramientas donde luego 
se abre el composite Band de la siguiente manera y como se ve en la 
Figura 16. ArcToolBox → Data Management Tools → Raster → Raster 
Processing → Composite Band 
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Figura 15. Carga de imágenes en el programa ArcGIS 

 

 
Figura 16. Empaquetado de la imagen con la herramienta “Composite Band”  
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Se da doble clic en “Composite Band” y se despliega una ventana donde 
se ingresan las bandas que componen la imagen en orden numérico del 1 
al 11 a través de “Imput Ráster”. En “Output Ráster” se guarda un nuevo 
archivo con un nombre definido por el usuario y terminado con la extensión 
.tif, para nuestro caso será Cordillera.tif. 

 
Luego de terminar este proceso la imagen se carga automáticamente en 
ArcGIS, ver figura 17. 

 
Luego se crea una composición en color verdadero con la imagen, ver 
figura 18, para ello se da clic en el nombre.tif y en “Properties”, donde se 
despliega una ventana, ver figura 19. 
 

 
 

Figura 17. Proceso de carga de la imagen. 
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Figura 18. Composición de color verdadero. 

 
En la pestaña “simbology” se da las diferentes combinaciones de banda 
de acuerdo con las composiciones que se quieran buscar. 

 

 
Figura 19. Combinación de bandas. 
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Luego se selecciona el RGC composite para asignar el número de las 
banda de acuerdo a lo que se quiera representar, en la siguiente tabla se 
puede observar algunas características de las bandas de Landsat: 

 

 
 

Tabla 1. Bandas de Landsat 8 y sus características. 
 
El sensor OLI (Operational Land Imager)  

 
A bordo del Landsat 8, se encuentra el sensor OLI, puesto en órbita en 
febrero del 2013. Las bandas espectrales capturadas por este sensor son 
muy parecidas a las del sensor ETM+ (a bordo del Landsat 7), aunque se 
han añadido dos nuevas: un nuevo canal en azul visible (banda 1) diseñado 
específicamente para observar la calidad del agua en lagos someros y 
zonas costeras, así como para detectar aerosoles, y otro canal en el 
infrarrojo (banda 9) para determinar la presencia de nubes -
fundamentalmente cirrus-. Asimismo, junto a cada escena del Landsat 8 se 
incluye también una banda de valoración de calidad (Quality Assurance 
band), que ofrece información respecto anomalías en la toma de datos por 
problemas en el instrumental o la presencia de elementos como nubes, 
agua y nieve. ⁵  

 
El sensor TIRS (Thermal Infrarred Sensor)  

 

El sensor TIRS capta información acerca de la temperatura de la superficie 
terrestre a través de dos bandas del infrarrojo térmico (banda 10 y banda 
11). Permite distinguir entre la temperatura de la superficie terrestre y la 
temperatura atmosférica. Tienen una resolución de 100 m. ⁵ 



                    Trabajo Opción de Grado para optar por el título de Ingeniería Civil 
                                                                                                          René Alejandro Restrepo Pérez 

29 

 

 

 
Combinación de bandas  

 
Las bandas multiespectrales de una imagen de satélite pueden visualizarse 
mediante distintas composiciones en color. Basta por ello aplicar cada uno 
de los tres colores primarios (rojo, verde y azul) a una banda distinta de la 
imagen, seleccionada con el criterio y el orden que se estime más oportuno. 
El proceso permite visualizar simultáneamente, imágenes de distintas 
regiones del espectro, lo que facilita la delimitación visual de algunas 
cubiertas. La elección de las bandas para realizar la composición, y el orden 
de los colores destinados a cada una, dependen del sensor sobre el que se 
trabaje y de la aplicación última del proyecto. 
 

 
 

Tabla 2. Composición de bandas de Landsat 8. 
 

5.8 Selección del Modelo Digital de Elevación. 
  

Desde el campo de herramientas de ArcGIS es posible acceder a las 
opciones de recorte de archivos ráster de manera individual o mediante 
recortes masivos de múltiples ráster. Dispondremos de la opción de recorte 
de archivos ráster desde ArcToolBox dentro de las herramientas de: Spatial 
Analyst > Extraction > Extract by Mask. ⁸ 
 
También se puede recortar una parte de un DEM (ráster). En la caja de 
herramientas de ArcToolBox se dispone de varias que permiten tomar un 
trozo de área siguiendo la ruta Extraction → Spatial Analyst → y cualquiera 
de los atributos como mask, polygon, rectangle y otros más. Ver figura 20. 

Con Input ráster seleccionamos el archivo DEM, luego en la ventana Input 
ráster or feature mask data, damos click en polígono, y, en Output 
ráster indicamos la carpeta y nombre del ráster. 
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Figura 20. Recortar un DEM (ráster) en ArcGIS 

Para crear finalmente el trozo de terreno que se requiere para desarrollar el 
trazado de la vía, se crea un Shapefile nuevo siguiendo la siguiente ruta 
(ver figura 21). 

 
 

Figura 21. Creación de un shapefile a partir del MDE seleccionado. 

Creado el shapefile se procede al cálculo de las variables topográficas para 
la descripción del terreno. 

 
Para dar coordenadas y valores de Z al Shapefile en ArcGIS, primero hay 
que tener el modelo de elevación digital .tif o el DEM o TIN, luego se hace 
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la siguiente ruta: ArcToolBox → 3D Analyst Tools → Functional Surface 
→ Add Surface Information, luego, en Imput Features Class, 
seleccionamos el archivo de puntos .shp, en Imput Surface se selecciona 
el modelo .tif y, en Output Property marcar la columna correspondiente a 
la cota o Z, de esta forma aparece una columna con los datos de elevación 
o cotas en la tabla de atributos. 

 
Para georreferenciar la imagen a coordenadas WGS 1984, damos clic 
derecho en Layer y abrimos Propiedades, a continuación, seguimos la 
siguiente ruta: Properties → se abre la ventana Data Frame Properties → 
luego la pestaña Coordinate System → entramos a Projected Coodinate 
System → Magna Colombia Bogotá. 
 

 
Figura 22. Como dar coordenadas y valores de Z al Shapefile en ArcGIS 

 
Finalmente, para delimitar la zona donde se desarrolla el proyecto vamos a 
utilizar la herramienta Editor haciendo la siguiente ruta: Editor → Start 
Ending → indicamos el archivo shapefile, en nuestro caso 
Cordillera1.shp → Ok → Ok.  

 
Aparece una ventana llamada “Créate Features”, damos clic en 
“Cordillera.shp”, apareciendo en la parte inferior  
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un cuadro de herramientas llamado “Constrution Tools”, allí 
seleccionamos “Polygon”, luego en el editor “Editor” damos “Stop 
Ending” y salvamos. 

 
Ahora se extrae el nuevo shapefile siguiendo la siguiente ruta: ArcToolBox 
→ Spatial Analyst Tools → Extraction → Extract by Mask → en Import 
ráster incluimos el archivo .tif, en este caso Urarco2.tif, en Output ráster 
incluimos el archivo shapefile, en este caso, Cordillera1.shp. En guardar 
se le da finalmente el nombre con la extensión .tif, para este caso, 
Cordillera2.tif. 

 
5.9 Cálculo de variables topográficas para descripción del terreno. 

 
Se calcularán las variables topográficas, basándose en el modelo de 
elevación digital del terreno. Se pretende de esta forma, llegar al cálculo de 
curvas de nivel, por medio de las herramientas que trae el Spatial Analyst 
de ArcGIS. 

 

Para poder realizar funciones de análisis espacial, se hace uso de la 
herramienta Spatial Analyst. En el menú, dar clic en Customize y luego 
dar clic en Extensions, para hacer activa la extensión dar clic en la caja de 
diálogo que corresponde a Spatial Analyst. 
 

 
Figura 23. Función de análisis espacial. 
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Mapa de pendientes 
 
La siguiente es la ruta para el mapa de pendientes: ArcToolbox →Spatial 
Analyst →Surface →Slope 
 

    
 

Figura 24. Mapa de pendientes. 
 

Luego se procede a hacer una reclasificación de pendientes utilizando cinco 
rangos. Con la herramienta Reclassify se crea un nuevo mapa ráster con 
los nuevos valores de acuerdo con una reclasificación del mapa original. 
 
La ruta por seguir es la siguiente: ArcToolbox →Spatial Analyst → 
RECLASS → Reclassify. 
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Figura 25. Reclasificación de pendientes. 
 
Mapa de sombras (Hillshade) 
 
Este mapa simula la morfología del relieve y sirve para visualizar el terreno 
antes de hacer el trazado definitivo. La ruta por seguir es la siguiente: 
ArcToolbox → Spatial Analyst → SURFACE → Hillshade.  
 

    
 

Figura 26. Mapa de sombras. 
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Curvas de nivel (Contour) 
 
Con esta herramienta se obtiene las curvas de nivel del área determinada 
para el trazado final de la vía. La ruta por seguir es la siguiente: 
ArcToolbox → Spatial Analyst → SURFACE → Contour  

 

  
 

Figura 27. Tabla de herramientas para el cálculo de curvas de nivel. 

 
El intervalo de las curvas de nivel es de 10 m. 

 

5.10. Conversión de curvas de nivel de ArcGIS a AutoCAD. 
   

Para pasar los puntos con cota o curvas de nivel con cota, primero hay que 
añadir al shapefile con nombre “elevación” para que luego, AutoCAD lo 
reconozca; los datos de altura o “z” se copian y se pegan en el nuevo 
campo creado con la herramienta “Field calculator” y se guarda. 
Finalmente se exporta a AutoCAD con “Export to cad”. 
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Figura 28. Exportar curvas de nivel de ArcGIS a AutoCAD. 

    
Esta herramienta crea archivos CAD DWG, DXF o DGN.  Para 
poder transformar un archivo shapefile en un archivo CAD damos clic 
derecho sobre el shapefile deseado y seleccionar la opción Data → Export 
to CAD. Otra de las opciones posibles es recurrir a las herramientas 
de ArcToolBox desde la ruta Conversion Tools → To Cad → Export to 
CAD. 

 

 
Figura 29. Curvas de nivel en AutoCAD. 

 

https://geoinnova.org/cursos/curso-de-autocad-map-3d-orientado-a-la-gestion-de-proyectos-medioambientales/
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6. DISEÑO GEOMÉTRICO PLANTA PERFIL 
 
6.1 Definición de elementos de diseño 

 

Partimos diciendo que nuestro proyecto está pensado en un terreno de 
difíciles condiciones, tanto de topografía, pues es un terreno en su totalidad 
montañoso y escarpado, como la presencia de fallas geológicas y la 
presencia de un buen número de cuerpos de agua.  

 
Dado el avance tecnológico en los últimos tiempos, las modificaciones en la 
normatividad para el diseño de vías son comunes, no solo por la velocidad 
de diseño que son cada vez más altas, sino también por el tamaño de los 
vehículos que en algunos casos son más pequeños y livianos y en otros 
mucho más grandes y pesados. 

 
Se presenta en estas notas la geometría, las ecuaciones y las ventajas para 
la utilización de curvas circulares para este tipo de carreteras de difícil 
topografía, tangentes muy cortas y una velocidad de diseño muy baja. 
 

6.2 Metodología 
 

Para la realización del diseño geométrico, se consideraron las siguientes 
actividades: 

 
- Definición de la velocidad de diseño del proyecto, la cual se estableció 

en 30 kph considerando la importancia del proyecto y la topografía que 
presenta condiciones favorables para aceptar dicha velocidad de diseño. 

 
- Con base en la velocidad de diseño se definieron los parámetros 

básicos, como son el radio mínimo, el ancho de sección transversal, la 
pendiente longitudinal máxima. 

 
- Se definió el alineamiento horizontal del proyecto, conservando en 

general el corredor del camino actual. 
 

- La definición del alineamiento vertical se basó en la economía de 
explanación adaptándose en lo posible al terreno existente. Las curvas 
verticales cumplen para la velocidad de diseño del proyecto. 

 
- Con el proyecto definido horizontal y verticalmente, se procedió al dibujo 

de las secciones transversales cada 10 metros y en escala 1:200. Con el 
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software especializado se obtienen las áreas de explanación y con 
éstas, se obtienen los volúmenes de corte y terraplén. 

 
6.3 Criterios de diseño 

 
Atributos como la estética, la comodidad, la economía, la funcionalidad, 
entre otros, son los llamados a tener en cuenta en el momento de diseñar 
una carretera, de tal manera que satisfaga al usuario final, y por ende 
determine el trazado definitivo de la vía. 

 

• Seguridad. 
Es el aspecto más importante en el diseño de una carretera. La 
curvatura debe ser uniforme y la visibilidad suficiente, tanto vertical como 
horizontal, además debe contar con una buena señalización. 

 

• Comodidad 
Mientras más uniforme es el diseño, más cómoda es la carretera. Con 
un diseño uniforme aumenta la comodidad porque los cambios en la 
velocidad bajan, al igual que las aceleraciones y desaceleraciones. Si no 
se cumple con esta premisa, se debe diseñar el carreteable con 
transiciones adecuadas en su curvatura. 

 

• Funcionalidad 
Se debe garantizar a los vehículos (conductores) que transiten por esta 
vía, una velocidad de 30 kph, siendo ésta una velocidad adecuada para 
lograr uniformidad y buena movilidad. 
La funcionalidad al fin al cabo la define la capacidad y los niveles de 
servicio entre otra característica, la definición del TPD, el volumen y la 
composición vehicular. 

 

• Entorno 
Causar en menor impacto posible al medio ambiente antes, durante y 
después de la construcción de la carretera. Adaptar el diseño de la mejor 
forma al relieve de la zona, más teniendo en cuenta que es una 
topografía muy quebrada. 
 

• Economía 
Sin castigar de alguna forma la calidad del proyecto se debe lograr un 
equilibrio entre diseño y los costos de construcción. 
 

• Estética 
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Se debe hacer una carretera con no afecte el paisaje, esto desde el 
punto de vista exterior; y desde el interior que el conductor se sienta 
cómodo y que el conducir sea agradable. 

 

• Elasticidad 
Consiste en hacer posible que la vía diseñada tenga la posibilidad de ser 
ampliada en un futuro y posibilitar la conexión con otras vías que 
permitan la comunicación entre las diferentes comunidades. También se 
refiere a la interacción de ésta con otros tipos de transporte multimodal 
como por ejemplo las vías fluviales, aéreos y ferrocarriles. 
 
 

6.4 Factores de diseño 
 

• Externos 
Estos corresponden a las condiciones preexistentes tales como: 

✓ Por características físicas, esta vía tiene una topografía 
escarpada que la hacen particular en cuanto a geología y 
geotecnia. 

✓ La zona tiene poco desarrollo urbanístico, pero posiblemente 
cuente con otros previstos para desarrollar en el futuro. 

✓ El uso de la tierra es de vocación netamente agrícola y ganadera. 
✓ La zona registra un índice de desocupación muy alto. 
✓ Se hace énfasis en la seguridad vial, la cual debe ser reforzada 

con una buena señalización. 
 

• Internos 
Corresponden a la propia vía, pero también dependen de algunos 
externos como: 

✓ Los vehículos y sus características. 
✓ La geometría de la vía y sus efectos. 
✓ El tipo de tráfico. 
✓ La capacidad de la vía. 
✓ El comportamiento de los usuarios. 
✓ Las facilidades de acceso a las propiedades y a otras vías. 
✓ La velocidad. 

 
 
 

 
6.5 Parámetros de diseño 
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Hay que partir de datos conocidos para el cálculo de los diversos elementos 
del trazado de una curva circular. 

Una curva circular simple es un arco cuya función es unir dos líneas rectas 
de la vía. 

La componen los elementos descritos a continuación: 

Ángulo de deflexión [Δ]: Es el ángulo formado por dos líneas rectas que 
se cortan en el trazado de la vía, puede ser ángulo agudo, obtuso, recto y 
convexo. También pueden ser ángulos derechos o izquierdos según el 
sentido de la vía. 

Tangente [T]: La tangente es una línea recta que une dos curvas, bien sea 
curvas circulares o curvas espirales, se llama entretangencia y va desde el 
PT hasta el PC siguiente o viceversa.  

 

• Radio [R]: Es la distancia que va desde el centro de la 
circunferencia de la curva que compone el arco. 

 

• Cuerda larga [CL]: Es la línea recta que une el PC y el PT de 
una curva de la vía.  

 

• Externa [E]: Es la distancia que hay entre el vértice del ángulo 
formado entre las dos líneas tangentes y el punto mas próximo a 
la curva.  

 

 

• Ordenada Media [M] (o flecha [F]): Es la línea recta que une el 
punto medio de la cuerda con el punto medio de la curva.  
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• Grado de curvatura [G]: Es la longitud que mide la curva de un 
arco.  

 

• Longitud de la curva [L]: Es la longitud de una curva medida 
desde el PC y el PT en el trazado de una vía. 

 

6.6 Creación del modelo digital 

 

Figura 30. Creación del modelo digital del terreno. 
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El siguiente paso se da cuando se tiene certeza de que la información ya ha 
pasado por un filtro de correcciones y ajustes que haga confiable el 
producto. La precisión y el ajuste de errores es primordial y deben cumplir 
con la tolerancia permitida. 

Con un archivo creado con extensión .cvs se da paso al uso del programa 
Strato, el archivo debe contener el número de detalle, coordenada este, 
coordenada norte y cota o altura, en ese orden. Al importar esta información 
al programa Strato aparece una nube de puntos interpolables que crea el 
modelo digital del terreno, luego de depurar y corregir los puntos erróneos. 

Por medio de una herramienta propia del programa Strato llamada polilínea, 
se perfeccionan las curvas de nivel, obligando de cierta forma a que la 
triangulación tenga en cuenta las características más relevantes del terreno 
como son los hombros del talud o llamadas también coronas del talud, la 
pata del talud, los bordes de vía, los bordes de quebrada, etc. 

Finalmente se exporta el modelo digital del terreno a AutoCAD para 
proceder a hacer el diseño de la vía. 

6.7 Ubicación del proyecto 

El proyecto Vía El Siento-La Cordillera se ubica en el corregimiento de 
Tabacal, del municipio de Buriticá, y se proyecta como un tramo de vía que 
comunicaría en el futuro con el municipio de Peque, en el extremo 
occidente del departamento de Antioquia. Esta vía dará acceso no solo a 
este municipio sino también al corregimiento Llanos de Urarco de Buriticá. 

El estudio preliminar de alternativas recomendó dos posibles trazados entre 
La Cordillera y Llanos de Urarco, ya que la topografía es de alta pendiente y 
con recurrentes fallas geológicas.  

Un primer tramo es la vía existente entre el corregimiento de Tabacal hasta 
la vereda El Siento, la cual cuenta en gran parte con placa huella hecha 
recientemente, y con buenas características físicas tanto en lineamiento 
horizontal como vertical, lo que le da un buen margen de seguridad al 
conductor. En la imagen siguiente se puede observar, figura 30. 
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Figura 31. Tramo de vía existente entre Tabacal y El Siento. 

El tramo a continuación es el tramo al cual se le hizo un estudio más 
detallado, haciendo uso de diferentes programas como el ArcGIS, el Strato 
y el AutoCAD, y cuyo tramo se extrajo del shapefile objeto del presente 
trabajo.  

En el numeral 5.8, “selección del modelo digital de elevación”, se generó el 
archivo DWG de curvas de nivel, se extraen las curvas de nivel del proyecto 
en el tramo que va desde la vereda El Siento hasta la vereda La Cordillera, 
las curvas de nivel se generaron cada 5 metros. Este archivo DWG se 
convierte a uno DXF para poderlo importar al programa Strato. 

Una de las alternativas va hacia el lado izquierdo de la vereda La Cordillera 
que está a una altura de 2035 msnm, por un carreteable existente que llega 
hasta la Vereda La vega, de allí parte un camino hasta la vereda Las Cuatro 
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y Palenque a una altura de 960 msnm. El desnivel es de 1075 metros 
aproximadamente, en un tramo de 7 kilómetros entre estas dos veredas. 
 
 

7 RESULTADOS 
 

7.1Trazado vía nueva desde la vereda La Cordillera al corregimiento 
Llanos de Urarco 

 
Con el objetivo de dar continuidad a la vía existente y dar otra alternativa de 
comunicación entre el municipio de Peque y la capital del departamento, se 
plantea el siguiente trazado entre la vereda La Cordillera, que ya cuenta con 
una vía que cumple con normas INVIAS, y el corregimiento Llanos de 
Urarco, en el municipio de Buriticá. 
 
Dado que las imágenes “bajadas” del satélite Lansat no generaron curvas 
de nivel de calidad, se procedió a “bajar” una imagen de la plataforma 
EarthData (Búsqueda de datos ASF (alaska.edu), del satélite Alos Palsar 
que cuenta con una resolución de 10 m, mucho más confiable que la 
resolución de 30 m del Landsat. 
 
Con las curvas de nivel creadas con la imagen de Alos Palsar se procede a 
definir el trazado luego de convertirlas a AutoCad, se hace tratando en lo 
posible, cumplir con las normas de diseño geométrico planta-perfil para una 
vía de segunda categoría o secundaria. Entre otras normas, se tiene 
especial cuidado en manejar pendiente longitudinal no superiores al 17% y 
curvas horizontales mayores a 18 m con sobreancho, y velocidad de diseño 
de 30 kph. 
 
Con el trazado de la vía definida se importa al programa ArcGIS con el 
comando Add Data, una vez en la tabla de contenido se da click derecho a 
la capa de la vía, y se sigue la siguiente ruta: Data → Export Data y se da la 
ruta de la carpeta destino, el nombre y se asegura de guardarlo como 
shapefile. Ver la imagen siguiente. 
 

https://search.asf.alaska.edu/#/
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Figura 32. Importación del trazado de la vía de AutoCad a ArcGIS. 

A continuación, creamos un Buffer con ancho 300 metros a partir del eje de 
la vía como se ve en la imagen 33. 
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Figura 33. Creación del buffer. 

Con el buffer creado se procede a cortar las curvas de nivel, se toma la 
información del layer CurvaUrar_Projerct, la cual tiene la georreferenciación 
correcta, con coordenadas Magna Origen Oeste (no se trabajó con el nuevo 
sistema de coordenadas Origen Nacional, resolución 471 de mayo 14 de 
2020). La ruta es la siguiente: ArcToolbox → Analyst Tools → Proximity 
→ Buffer. 

Luego se hace un Clip para cortar las curvas de nivel correspondientes al 
buffer creado, se hace la ruta siguiente: ArcToolbox → Analyst Tools → 
Extract → Clip. 
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En lapróxima imagen se observa la secuencia para la obtención del Clip 

 

Figura 34. Secuencia para la obtención del Clip. 

Resumiendo, para extraer las curvas de nivel se necesitan básicamente dos 
elementos. El primero es contar con los datos para generar dichas curvas 
de nivel. Deben de provenir de diferentes fuentes, se hace referencia a dos 
más concretamente, una es poder contar con uan nube de puntos de 
elevación que se puedan interpolar para obtener líneas o curvas de nivel. 

La otra fuente poder contar con un archivo ráster que contenga información 
altimértrica, es decir, un modelo digital de elevación del terreno MDE, 
siendo esta última la opción seleccionada para el presente trabajo. 
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Además, vamos a requerir de una serie de herramientas en nuestro 

Sistema de Información Geográfica. Nos referimos a Buffer y Clip de la 

caja de herramientas ArcToolbox 
 

 
 

Figura 35. Creación del buffer y el clip con las curvas de nivel. 
 

El perfil topográfico se puede apreciar en la siguiente imagen, se observa 
algunos picos que se deben corregir cuando el proyecto esté en fase III o en 
etapa de ingeniería de detalle, es allí donde se hacen los ajustes en todos 
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los frentes. 
 

 
Figura 36. Perfil longitudinal K0.000 a K5+400. 

 

El alineamiento vertical lo conforma la rasante, la inclinación depende de la 
topografía de la zona, del alineamiento horizontal, de la visibilidad, de la 
velocidad de diseño, de los costos de construcción, los costos de operación 
y el porcentaje de vehículos pesados. El relieve del terreno del proyecto 
está en montañoso y escarpado, en la parte montañosa está limitado a las 
condiciones topográficas y, en las zonas escarpadas, el alineamiento 
vertical está definido por las divisorias de agua. 

 
Según la norma, la relación entre pendiente máxima (%) y la velocidad de 
diseño, nos dice que, para una vía con las características del proyecto, se 
tiene un tipo de carretera Secundaria si se llegase a terminar la vía hasta el 
municipio de Peque, para un tipo de terreno montañoso, una velocidad de 
diseño de 40 k/h, la pendiente será de P= 15%, y para terreno escarpado, 
una velocidad de 30 k/h, la pendiente será P=15%. 
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Si la vía solo fuera de tipo terciaria, la pendiente máxima para el terreno 
escarpado será del 16%, y para el terreno montañoso del 14%. ⁹ 

 

7.2 Coberturas y uso del suelo 
 

La cobertura del suelo o Land Cover es un término que se emplea para 
describir el tipo de material físico que cubre la superficie de la tierra, entre las 
coberturas tenemos el agua, los árboles, el tipo de pavimento o superficie de 
las vías o carreteables, el tipo de hierba, etc. 
 

7.2.1 Determinación de demanda ambiental 
 

La metodología CORINE Land Cover es una metodología para realizar el 
inventario de la cobertura de la tierra, fue promovido por la Comunidad 
Europea dentro del programa CORINE (Coordination of information on the 
evironment) en el año 1990. 
 
Colombia cuenta con una base de datos llamada Corine Land Cover 
Colombia (CLC) que permite caracterizar, describir, comparar y clasificar las 
características de la cobertura de la tierra, haciendo uso de imágenes de 
satélite de resolución media (Landsat). Otras imágenes de satélite utilizadas 
son SPOT, Sentinel2+Landsat 8, IRS. 
 
Para determinar el uso y cobertura de la zona de influencia de la vía objeto 
de estudio, con la imagen descargada del satélite Alos Palsar, recurrimos a 
ArcGIS y seguimos la siguiente ruta: 
 

 
Figura 37. Cálculo de las áreas de cobertura vegetal. 
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Sobre el layer “Cobertura buffer 300” hacemos click derecho y abrimos la 
tabla de Atributos – Open Attribute Table – ya en la tabla creamos una 
nueva columna la cual llamaremos Área ha, Click derecho sobre la columna 
UCS-F → click derecho en Summarize → buscamos Área ha y damos 
click en Sum, → definimos la ruta de destino → definimos el tipo de 
archivo (dbf). 

 

 
 

Figura 38. Cálculo de las áreas de cobertura del suelo. 
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7.2.2 Análisis e interpretación de coberturas 
 
La interpretación de las imágenes se lleva a cabo a través del uso del 
software ArcGIS, el resultado de las áreas en las diferentes coberturas del 
trazado y la zona de afectación se puede observar en la siguiente imagen y 
el resumen en la unidad de Resultados. 
 

 
Figura 39. Tabla de áreas de coberturas. 

 

La cobertura que más área ocupa a lo largo del corredor son los pastos 
limpios con área de 337.946 ha, la de menos área es la vegetación 
secundaria o de transición con un área de 9.878 ha.  
 
La metodología CORINE Land Cover considera seis niveles, el nivel uno se 
subdivide en cinco categorías que son: territorios artificializados, territorios 
agrícolas, bosques y áreas seminaturales, áreas húmedas y superficies de 
agua. 
 
La cobertura que amerita especial atención es la 3.1.4 dado el aporte que 
representa en los componentes agua, suelo y aire por lo que se deben 
tomar medidas de protección para su sostenibilidad y así evitar su deterioro. 
 
En total son 72,5 hectáreas, su distribución se puede apreciar en la figura 
38. Esta cobertura es muy importante para la conservación de los recursos 
de flora y fauna que habitan en esta zona. 
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Las áreas clasificadas en el nivel 1, Territorios Agrícolas, están compuestos 
principalmente por los pastos: pastos limpios, pastos enmalezados, en 
mosaico de pastos y cultivos y mosaico de cultivos, pastos y espacios 
naturales, de éstos el de mayor área es el de pastos limpios con 337.95 ha 
y representa el 36.20% del territorio; en segundo lugar están los Pastos 
enmalezados con 187.50 ha que representa el 20.09% del territorio, en 
tercer lugar está el mosaico de pastos y cultivos con 103.45 ha que 
representa el 11.08% del territorio. El mosaico de cultivos, pastos y 
espacios naturales cuenta con un área de 100.778 ha para un 10.80% del 
territorio. 
 
Lo anterior deja claro que la vocación que predomina en la zona de 
influencia del proyecto es la actividad ganadera representada en los pastos, 
con respecto a la actividad agrícola, ésta está representada en la existencia 
de cultivos de café principalmente y de caña panelera, también se observan 
cultivos transitorios. 
 

 
Figura 40. Cobertura bosques de galería y ripario. 
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7.2.3 Análisis e interpretación de suelos 

 
Nos adentramos en el tema de la composición del suelo en la zona del 
proyecto partiendo como base los estudios sobre geología regional del 
occidente antioqueño existentes en la bibliografía. 
 

 
Figura 41. Unidad de suelo HBf1. 

 
Se toma como base el estudio realizado en la referencia bibliográfica 12, 
donde se describe la geología de la zona. Las unidades geológicas en la 
zona están constituidas por rocas metamórficas, principalmente Anfibolitas 
que afloran como cuerpos de forma alargada y tamaño variable.  
 
Entre los Gnéisses de Horizontes y el Batolito Antioqueño, se observan 
lentes de diferentes tamaños, Gnéisses, Cuarcitas, Cuarzo Feldespáticas, 
Esquistos y Magmatitas. Los sedimentos cuatemarios son de origen aluvial, 
siendo el mas importante el depósito donde se encuentra la cabecera 
municipal de Santafé de Antioquia.  
 
La erosión hidríca se presenta como un fenómeno de escurrimiento intenso, 
erosión lineal agresiva, erosión laminar, erosión remontante y socavaminto 
lateral, desnudando las laderas de forma intensa en ciertas zonas. 
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Se tiene en la zona objeto de estudio cuatro unidades de suelo cuyas 
características son las siguientes: ALd1, HBf1, POdp y SBf2. 
 

• Unidad de suelo HBf1. La descripción dice que el paisaje es de 
Montaña, el clima es frío húmedo, el tipo de relieve es filas y vigas, la 
litología está compuesta por rocas ígneas (diabasas y basaltos) y 
depósitos de cenizas volcánicas. 
  
Características: Profundos y superficiales limitados por piedra y gravilla, 
bien drenados, texturas al tacto moderadamente fina y medias con 
fragmentos de roca, reacción muy fuerte y fuertemente ácida, fertilidad 
baja 

 

 
Figura 42. Descripción unidad de suelo HBf1 

 

 

NOMBRE 
UNIDAD DE 

SUELOS IGAC 

AREA 
(ha) 

ALd1 1,365 

HBf1 76,526 

POdp 10,867 

SBf2 844,635 

  
Tabla 3. Tabla de áreas de unidades del suelo. 

 



                    Trabajo Opción de Grado para optar por el título de Ingeniería Civil 
                                                                                                          René Alejandro Restrepo Pérez 

56 

 

 
Figura 43. Unidad de suelo POdp. 

 

 
Figura 44. Descripción unidad de suelo POdp. 

 

• Unidad de suelo POdp. La descripción dice que el paisaje es de 
montaña, el clima es templado húmedo a muy húmedo, el tipo de relieve 
es glacís y coluvios de remoción, la litología corresponde a depósitos 
heterométricos mixtos coluviales y coluvio-aluviales. 
Características: Profundos a moderadamente profundos, bien 
drenados, texturas finas a moderadamente gruesas, erosión ligera a 
moderada, fertilidad muy baja y alta. 
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Figura 45. Unidad de suelo ALd1. 

 

 
Figura 46. Descripción unidad de suelo ALd1. 

 

• Unidad de suelo ALd1. La descripción dice que el paisaje es de 
montaña, el clima es frío húmedo a muy húmedo, tipo de relieve glacís y 
coluvios de remoción, la litología cenizas volcánicas depositadas sobre 
coluviones y aluviones heterogéneos. 
Características: profundos a moderadamente profundos, drenaje 
natural bueno, texturas finas a medias, reacción fuertemente ácida, 
fertilidad moderada, erosión ligera a moderada. 
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Figura 47. Unidad de suelo SBf2. 

 

 
 Figura 48. Descripción unidad de suelo SBf2. 

 

• Unidad de suelo SBf2. Esta unidad es la abarca casi la totalidad del 
terreno del proyecto, la descripción dice que el paisaje es de montaña, el 
clima templado húmedo a muy húmedo, el relieve filas y vigas, la 
litología rocas ígneas (diabasas, basaltos, tobas y dioritas), con 
cobertura discontinua de cenizas volcánicas. 
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Características: Profundos, limitados por gravillas y cascajo, bien 
drenados, alta saturación de aluminio, reacción extremada a ligeramente 
ácida, fertilidad alta a moderada, erosión ligera a moderada. 

 
7.3 Análisis e interpretación de fallas 

 
Los elementos geomorfológicos que conforman la estructura básica del 
relieve en la zona del proyecto son los frentes erosivos y cañones y las 
superficies de erosión 
 
Se presenta en la siguiente imagen el mapa de lineamientos y línea de falla 
próximas al proyecto. Las direcciones principales de linemaiento son en 
sentido N-S, coincidiendo con las trazas de las fallas de Tonusco en la 
margen derecha y la falla de Cañasgordas a la izquierda. 
 

 
Figura 49. Falla Tonusco (lado derecho). 

 
La falla de Cañasgordas tiene rumbo sinestral, en este tipo de fallas 
predomina el desplazamiento horizontal, aunque la falla paralella a la falla 
de Tonusco, que no tiene nombre asignado y que tiene desplazamiento 
vertical, también tiene dirección S-N como una derivación de la falla de 
Cañasgordas. 
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Figura 50. Falla Cañasgordas (lado inferior izquierdo). 

 
Con los fenómenos tectónicos asociados a la aparición de la falla de 
Romeral, corre con una dirección aproximada Norte-Sur en las 
inmediaciones del rio Cauca. El sistema de fallas presenta principalmente u 
na dirección Noroeste-Suroeste siendo mas o menos paralelas entre sí y 
afectando por igual las rocas del batolito y las anfibolitas y los 
metasedimentos.  

 
USO Y COBERTURAS AREA (ha)

2.2.2. Cultivos permanentes arbustivos 40,776

2.3.1. Pastos limpios 337,946

2.3.3. Pastos enmalezados 187,504

2.4.2. Mosaico de pastos y cultivos 103,455

2.4.3. Mosaico de cultivos, pastos y espacios naturales 100,778

3.1.4. Bosque de galeria y ripario 72,553

3.2.1. Herbazal 80,503

3.2.3. Vegetacion secundaria o en transicion 9,878  
Tabla 4. Resumen de áreas de coberturas. 
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ITEM GRUPO DE USO 
ÁREA 
(ha) 

PORCENTAJE 
(%) 

2.2.2 Cultivos permanentes arbustivos 40,776 4,369 

2.3.1 Pastos limpios 337,946 36,206 

2.3.3 Pastos enmalezados 187,504 20,088 

2.4.2 Mosaico de pastos y cultivos 103,455 11,084 

2.4.3 
Mosaico de cultivos, pastos y 
espacios naturales 100,778 10,797 

3.1.4 Bosque de galería y ripario 72,553 7,773 

3.2.1 Herbazal 80,503 8,625 

3.2.3 
Vegetación secundaria o en 
transición 9,878 1,058 

        

    933,393 100 

Tabla 5. Resumen porcentaje de áreas de coberturas. 
 

 
Figura 51. Distribución porcentual por grupo de uso de las coberturas. 
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El grupo más representativo de los ocho existentes, es el de pastoreo 
extensivo (PEX) con el 56%, en segundo lugar, está el de producción-
protección con el 22%. 
 

ITEM
NOMBRE UNIDAD 

DE SUELOS
ÁREA (ha)

PORCENTAJE 

(%)

1 ALd1 1,365 0,146

2 HBf1 76,526 8,199

3 Podp 10,867 1,164

4 SBf2 844,635 90,491

933,393 100  
Tabla 6. Resumen porcentaje de áreas unidad de suelos. 

 

 
Figura 52. Distribución porcentual por unidad de suelos. 

 
7.4 Cuerpos de agua. 

 
Se sabe de la existencia de cuerpos de aguas naturales permanentes, 
algunas intermitentes y estacionales que comprenden cuerpos de agua en 
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movimiento, depósitos y estanques naturales. A continuación, se muestra la 
ubicación de los más representativos. 

 
Figura 53. Quebrada 1 - K0+850. 

 

 
Figura 54. Quebrada 2 - K3+220. 

 

 
Figura 55. Quebrada 3 K7+870. 
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Figura 56. Quebrada 4 K8+330. 

 

 
Figura 57. Quebrada 5 K16+380. 

 
El tipo de obra debe ajustarse a las realidades y característica propias de 
cada cuerpo de agua, al realizar los estudios preliminares, el resultado debe 
definir el tipo de obra adecuada que cumpla con el objetivo.  
 

 
7.5  Carreteables existentes. 

 
Existen dos vías que comunican a la vereda La Cordillera con las veredas 
La Vega y La vereda Las Cuatro, son vías que no cumplen con ninguna 
norma técnica, de difícil tránsito y muy peligrosas. Fueron construidas de 
forma empírica, con altas pendientes longitudinales y curvas horizontales de 
radio muy pequeño; no cuenta con peraltes ni obras de drenaje. 
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Ha ocurrido muchos accidentes con un saldo trágico, solo es posible 
transitarlo en vehículos 4X4 tipo campero o camiones, por lo anterior se 
descarta la posibilidad de emplear este corredor. 
 
En la siguiente imagen se puede apreciar parte del trazado de la vía que 
conduce a la vereda La Vega, se puede apreciar en color magenta. 
 

 
 

Figura 58. Vía que comunica las veredas La Cordillera-La Vega de color 
magenta. 
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8. IMPACTO 
 

Se verán beneficiadas todas las comunidades que están entre el corregimiento 
Tabacal y el corregimiento Llanos de Urarco. La zona tiene mucho potencial 
agrícola con cultivos de café y explotación ganadera, también maíz, arroz, 
caña panelera, existen muchos trapiches, pero los productores tienen 
dificultades para sacar el producto al mercado, por lo que tienen que hacerlo 
en el municipio vecino de Peque.  
 
En el futuro esta vía se puede conectar con el municipio de Peque, pues es 
uno de los objetivos, dándole otra salida más corta hacia la capital del 
departamento, además de facilitar el desarrollo de zonas que se encuentran 
incomunicadas. 
 
Mejora la calidad de vida de las comunidades de las veredas Las Cuatro, 
Palenque, La Vega, La Cordillera entre otras, aumentando la actividad 
económica, mejorando los espacios rurales, incentivando mejores prácticas 
agrícolas.  
 
Las variables que impactan de acuerdo con diferentes métodos de valoración 
dentro del marco socioeconómico, después de la construcción de una carretera 
están la variable económica, la demográfica, la laboral, usos del suelo y 
movilidad. 
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9. CONCLUSIONES 

 
Se cumple con las expectativas al aplicar el programa ArcGIS en el trazado de 
obras de infraestructura vial. Después de plantear varias alternativas de 
trazado, todas partiendo de la vereda La cordillera, se llega a la selección de la 
vía objeto del presente estudio. 
 
Se selecciona esta alternativa porque ofrece mejores posibilidades de tener 
pendientes longitudinales inferiores al 17% y radios de curvatura máximos de 
20 m. Abarca una mayor cantidad de veredas que se verían beneficiadas al 
tener la posibilidad de sacar los productos a otros mercados, diversificar 
cultivos y ampliar el abanico de posibilidades comerciales. 
 
Un insumo muy importante fueron las imágenes de sensores remotos 
obtenidas; las obtenidas de sensores remotos pasivos Landsat8 no se 
pudieron utilizar debido a la longitud de pixeles tan amplio, de 30 m, lo que no 
permite obtener curvas de nivel confiables y de buena calidad para este tipo de 
proyectos, por lo tanto, se descartaron. En su defecto, las imágenes obtenidas 
de sensores remotos activos Radar Alos Palsar, fueron las seleccionadas dado 
el tamaño de pixeles de 10 m, se generó un modelo digital de buena calidad 
para obtener la topografía y diseñar el trazado de planta-perfil. 
 
Con la obtención de información secundaria de suelos, cobertura y usos del 
suelo y de fallas geológicas, se logra dar al proyecto claridad en componentes 
fundamentales para la toma de decisiones. Por ejemplo, la cobertura vegetal 
predominante es la de pastos lo que indica la vocación ganadera de la zona, 
los bosques protectores están alrededor de los cuerpos de agua, los cultivos 
en su mayoría son el café y productos de pancoger. Todos se verían 
beneficiados. 
 
De acuerdo con la cuantificación de los suelos según su clase agrológica, se 
puede deducir que la mayor parte de su área debe ser dedicada al uso 
exclusivo de bosques protectores o áreas silvestres, pues un alto porcentaje 
tiene un relieve de montaña y terreno escarpado, no aptos para la agricultura ni 
ganadería. 
 
Con la información obtenida se pudo identificar los riesgos, el manejo de 
cobertura y las obras para protección de cauces. 
 
Solo una pequeña parte posee el suelo tipo HBf1, que se presenta como un 
suelo inestable, con gran propensión a movimientos en masa. 
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Es indispensable contar con más tiempo para poder desarrollar el diseño mucho más 
completo y llegar a elaborar un mejor producto, por ejemplo, la búsqueda de las 
imágenes requiere de ello porque no todas nos permiten obtener buenas curvas de 
nivel.  
 
Las imágenes de satélites como Landsat, que tiene los pixeles con una longitud de 30 
m, no sirven para llegar al nivel de detalle que se requiere en las curvas de nivel, por 
lo anterior hubo que recurrir a la búsqueda de otras alternativas como los sensores 
remotos activos de Alos Palsar, con pixeles de 10 m de magnitud. 
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